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1. บทนํา 
1.1. คําแนะนาํในการใชคูมือ 

 
คูมือฉบับนี้เปนคูมือสําหรับการติดตั้งและใชงาน PS406 และ PS406U เครื่องสแกนเอกสารสองหนาอัตโนมัติความเร็วสูง 
สําหรับคูมือฉบับนี้อางอิงการใชงานรวมกับ Windows 2000 / XP/ Vista/ 7 ซึ่งหากคุณใชวินโดสรุนอ่ืนๆ หนาจออาจ
เปลี่ยนแปลงไปบางเล็กนอย  
 
ในสวนของบทนําในคูมือนี้ จะแสดงถึงรายละเอียดโดยรวมของคูมือแตละหัวขอและอุปกรณที่แนบมากับสินคา ดังนั้น
กอนที่คุณจะทําการติดตั้ง กรุณาตรวจสอบใหแนใจกอนวา มีอุปกรณในกลองครบตามที่บอกไวในคูมือ หากไมครบกรุณา
สอบถามจากผูขาย  
 

1.2. ขอควรระวัง 
กอนติดตั้งและใชงาน PS406/ PS406U กรุณาอานขอควรระวังดังตอไปน้ี เพ่ือปองกันอันตราย อันอาจจะเกิดแกอุปกรณ
และผูใช 
1.   การลดลงของความชื้นอาจทําใหอุปกรณภายในบางชนิดเสียหาย ซึ่งสาเหตุอาจเกิดจาก 

- เมื่ออุปกรณถูกเคลื่อนยายจากที่รอนไปสูที่เย็น 
- เมื่อหองที่วางอุปกรณรอนขึ้น 
- เมื่ออุปกรณอยูในหองที่มีความชื้นสูง 

2. เพ่ือหลีกเลี่ยงการลดลงของความชื้น  มีคําแนะนําดังนี้ 
- หุมอุปกรณดวยพลาสติก เมื่อสภาพในหองเปลี่ยนแปลงไป 
- รอประมาณ 1-2 ชั่วโมงกอนจะนําอุปกรณออกจากกระเปา 

2.   ใช AC adapter และสาย USB ที่ใหมากับ PS406/ PS406U เทานั้น 
3.   ในกรณีที่คุณตองถอด AC adapter แบบฉับพลัน ใหเหลือพ้ืนที่วางรอบๆ AC adapter  
4.   เก็บสายใหตรง ไมบิดเบี้ยว โคงงอ หรือชํารุด เพราะอาจเปนสาเหตุใหเกิดไฟฟาลัดวงจรได 
5.   ถอดสายอุปกรณเมื่อไมใชแลว 
6.   หามชน เคาะ หรือ กระแทก PS406/ PS406U แรงๆ เพราะอุปกรณภายในอาจเสียหายได 

1.3. ระบบที่แนะนํา 
PC with Intel Pentium®III 1G processor or compatible / 256 MB RAM / Available USB 2.0 port /     
CD-ROM Drive or DVD-ROM Drive / 800 MB Free Hard Disk Space / Video card that supports 16-bit 
color or greater / Operating System: Windows 2000 Professional, Windows XP Home (compatible), 
Windows XP Professional (compatible), Windows Vista, Windows 7 
สําหรับระบบที่เหมาะสมคือ  Pentium®4 1.8G หรือสูงกวา, 512 MB RAM, พ้ืนที่วางในฮารดดิสก1GB 



4 | P a g e  
 

1.4. อุปกรณในกลอง 

 
1. สแกนเนอรรุน PS406/ PS406U 
2. สาย USB 1 เสน 
3. อแดปเตอร 1 อัน 
4. ถาดรองกระดาษ 1 ชิ้น 
5. คูมือยอ 1 แผน 
6. ซีดีไดรเวอรและโปรแกรม 1 แผน  
7. แผน Calibration 1 แผน 
8. Memo Label 1 แผน 
9. ผาทําความสะอาด 1 ผืน 
10. Pad Module 1 ชิ้น 
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1.5. สวนประกอบบนตัวเคร่ือง 

 
1. PAPER CHUTE —ถาดรองเอกสารสําหรับการสแกนอัตโนมัติ 
2. PAPER WIDTH SLIDER—แถบกั้นกระดาษใหกระดาษตรง 
3. COVER OPEN LEVER—ปุมสําหรับดึงเพ่ือเปดฝาสแกนเนอรออก 
4. STACKER—ถาดรองเอกสารที่สแกนแลว  
5. ADF—สวนที่ใชสแกนอัตโนมัติ  
6. PAPER CHUTE EXTENSION —แผนรองกระดาษกรณีกระดาษที่ยาวมากๆ 

 
7. POWER SAVING BUTTON – กดคางไวประมาณ 0.5 วินาทีเพ่ือเขาสู Standby mode (sleep mode) และกดอีกคร้ัง
เพ่ือใหเครื่องพรอมใชงาน 
8. POWER/ POWER SAVING LED – ไฟแสดงสถานะการทํางาน 
9. UP BUTTON – กดเพ่ือเลื่อนตัวเลขฟงกช่ันขึ้น 
10. DOWN BUTTON – กดเพื่อเลื่อนตัวเลขฟงกช่ันลง 
11. SCAN BUTTON – กดเพื่อสั่งสแกน 
12. FUNCTION NUMBER DISPLAY – ชองแสดงหมายเลขฟงกชั่นที่ใชสแกน 
13. WARNING LED – ไฟเตือนเมื่อเกิดความผิดพลาดในการทํางาน 
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14. USB PORT – ชองเสียบ USB 
15. POWER RECEPTOR – ชองเสียบอแดปเตอร 
16. POWER SWITCH – สวิทซเปดปดเครื่อง 
 

1.6. LED Indicator (ไฟเตือนสถานะการทํางาน) 
ไฟเตือน สีของไฟปุม Power สถานะของเครื่อง 
ปด ขาว สแกนเนอรเปดอยู พรอมใชงาน 
ปด สม สแกนเนอรอยูใน Standby mode (Sleep mode) หากเครื่อง

ไมไดใชงานเกิน 10 นาที 
แดง ไฟขาวกระพริบ ฝาสแกนเนอรเปดอยูหรือปดไมสนิท 
ไฟแดงกระพริบ ขาว กระดาษติด 
ไฟแดงกระพริบ ปด อุปกรณบางตัวในเครื่องสแกนเนอรใชงานไมได 
ปด ปด ปดเคร่ือง อาจเปนเพราะลืมเปดสวิทซดานหลัง หรือไมไดเสียบ

อแดปเตอรก็ได 
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1.7. Ultrasonic sensor 

 
สําหรับฟงกชั่น Ultrasonic จะมีเฉพาะสแกนเนอร PLUSTEK รุน PS406U เทานั้น Ultrasonic sensor ใชตรวจจับ

กระดาษที่อาจจะซอนกัน (เชนดึงกระดาษครั้งละ 2แผนหรือมากกวานั้น) หากจําเปนตองทําความสะอาดใหใชผาแหงเช็ด
อยางเบามือ 
 

1.8. คุณสมบติั PS406/ PS406U 

 

• เคร่ืองสแกนภาพแบบ Sheet-Fed   
• สแกนสองหนาไดพรอมๆกนั (Duplex scanning) 
• สแกนสี ความละเอียดสูงถึง 600 Dpi  
• ความเร็วในการสแกนหนาเดียว 40 ppm, สแกนสองหนา 80 ipm 

 

• มีฟงกชัน่สแกนขามหนาวางอัตโนมัติ, ปรับเอียงอัตโนมัติ, ปรับขนาดกระดาษอัตโนมัติ (Auto size 
scanning), ครอบตัดอัตโนมัติ เปนตน 

• ถาดใสเอกสาร ใสไดถึง 100 แผน 

 

• สแกนไดทั้งกระดาษ A4, นามบัตร, บัตรพลาสติก และบัตรเครดิต ไดเปนอยางดี 
• เพียงกดปุมก็สแกนเปนไฟลรูปภาพ เชน JPEG, BMP, PNG, TIFF, Multi-TIFF, PDF, Searchable 

PDF หรือจะสแกนเพื่อสงอีเมล, สั่งพิมพออกเครื่องพิมพ  และสแกน OCR เพ่ือบันทกึเปน Word หรือ 
Excel ก็สามารถทําไดทนัที โดยไมตองรออุนเครื่องแตอยางใด 

ซอฟแวรที่แถมให 
PageManager โปรแกรมสแกน, จัดเก็บ, จัดรูปเลม, เรียงหนา และคนหาเอกสาร  

HotCard BizCard โปรแกรมจัดเก็บและคนหาขอมูลในนามบัตร  
IRIS Readiris Pro 

Corp. 
โปรแกรมแปลงไฟลภาพเอกสารใหเปน Word, Excel โดยไมตองพิมพใหม โดยคงรูปแบบเดิมไวทั้งภาพและ
เนื้อหา  

DI Capture โปรแกรมที่ชวยใหคุณสแกน, นําเขา, จัดหมวดหมู และจัดการงานเอกสารไดอยางเปนระบบ 
DocAction โปรแกรมที่ใชในการตั้งรูปแบบการสแกนใหกับปุมบนตัวเครื่อง  
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Specification 
Scanning Type  CCD Sensor (Duplex)
Optical Resolution  600 x 600 dpi
Scan modes  Color : Input 48‐bit; Output 24‐bit

Grayscale : Input 16‐bit; Output 8‐bit 
Black & White : 1‐bit 

ADF Capacity  100 sheets (A4/Letter, 70 g/m2 or 18 lb.)
ADF Scanning Speed  40 ppm/ 80 ipm (200 dpi, A4,color mode)

20 ppm/ 40 ipm (300 dpi, A4,color mode) 
Scanning Area   A4 : 216 x 356 mm (8.5" x 14")

Long paper 216 x 1270 mm (8.5” x 50”) 
Min. 13.2 x 13.2 mm (0.52” x .52”) 

Acceptable Paper Sizes  A4/ A5/ Letter/Legal size
Max. 245 x 1300 mm (9.65" x 51") 
Min. 13.2 x 13.2 mm (0.52" x 0.52") 

Acceptable Paper Weight  50 to 105 g/m2 (14 to 28 lbs.)
Card thickness  Up to approx. 0.76 mm in thickness + embossing (ISO standard / JIS 

standard) 
Action button  Up, down, scan, standby
Power supply  Input Voltage : 100~240V / Output Voltage : 24V, 1.25A 
Environment Requirement  WEEE/ROHS
Interface  USB 2.0
Weight  2.7 Kg (5.95 lb.)
Dimensions (W x D x H)  318.4 x 329.8 x 228 mm (12.53" x 12.98" x 8.97")
Protocols  TWAIN Compliant
OS  Windows XP, 2000, Vista, 7
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2. การติดต้ังสแกนเนอรและการทดสอบเบื้องตน 
2.1. การติดต้ังฮารดแวร 

เชื่อมตอสแกนเนอรกับเครื่องคอมพิวเตอรตามภาพ กอนใชงานกรุณาตรวจสอบใหแนใจวาเครื่องเปดอยู 

 
 

2.2. วิธีการใสถาดรองกระดาษ 
1. เปดฝาสแกนเนอรออกตามภาพ   
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2. ใสถาดรองกระดาษใหลงล็อคตามภาพ  

 
3. ปดฝาสแกนเนอรใหลงล็อคตามภาพ 

 
 

2.3. การติดต้ังซอฟแวร 
หลังจากตอสแกนเนอรเขากับเครื่องคอมพิวเตอรแลว เปดเครื่อง  จากน้ันใหทําตามขั้นตอนดังตอไปนี้ 

1. เมื่อหนาจอขึ้น Add new hardware หากสแกนเนอรไมไดเปด จะไมมีขอความนี้ข้ึน  จากน้ันคลิก Next 
2. เลือก Search for the Best Driver for Your Device [Recommended] จากนั้นคลิก Next 
3. จะมีขอความถามหา Driver จากแผน ซีดี ใหใสแผนซีดีที่มาพรอมกับเครื่องลงไปในเครื่องแลวคลิก Next 
4. ติดตั้งเสร็จแลวใหคลิกที่ Finish 
5. กลับมาที่หนาจออีกคร้ังจะปรากฏหนาจอใหติดตั้งโปรแกรมตางๆที่แถมมาใหตามภาพ  
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6. คลิกที่ Install software  หนาจอถัดไปใหคลิกที่ Typical installation หนาจอถัดไปใหคลิกที ่Install 
7. จากนั้นคลิก Next ไปเรื่อยๆจนกวาจะสิ้นสุดการติดตั้ง 
8. คลิกที่   เพ่ือออกจากหนาจอการติดตั้งโปรแกรม 
9. หลังจากติดตั้งโปรแกรมทั้งหมดเสร็จแลว รีสตารทเครื่อง 1 ครั้ง  
10. เมื่อเครื่องเปดเรียบรอยแลว หนาจอจะขึ้นขอความให Calibrate สแกนเนอร ทําไดโดยการใสแผน Calibrate ลง

ในถาดใสกระดาษ (หากไมมีใชกระดาษขาวแทนได แตเพ่ือประสิทธิภาพที่ดีที่สุด ขอแนะนําใหใชแผน Calibrate 
ที่ใหมาในกลอง) 

11. ทําตามขั้นตอนที่หนาจอแสดง จากน้ันคลิก OK และ Finish t เพ่ือเสร็จสิ้นการ Calibrate 
 

2.4. การทดสอบสแกนเนอร 
หลังจากติดตั้งสแกนเนอรเสร็จแลว ใหทําการทดสอบการใชงานเบื้องตนดังนี้ 

1. ใสกระดาษโดยการเอาหัวกระดาษลงและคว่ําหนาตามภาพ  

 
2. ไปที่เมนู Start แลวเปดโปรแกรม Presto Page Manager ที่ไดลงไปแลวกอนหนานี้ 
3. หากมีสแกนเนอรที่เชื่อมตอกับเครื่องคอมพิวเตอรอยูหลายตัว ใหไปที่ Select source จาก File แลวเลือก 

PS406 หรือ PS406U แตหากมี PS406 เช่ือมตออยูเพียงเครื่องเดียว ใหไปที ่Tools > Scan Settings > 
uncheck “Suppress TWAIN User Interface” > OK. Click File > Acquire Image Data. 

4. เลือก ADF (Front Side) จากหนาจอ Twain 
5. คลิกที่ปุมสแกน 
6. กระดาษจะถกูดงึและสแกนอัตโนมัติ เสร็จแลวภาพเอกสารจะปรากฏที่หนาจอคอมพิวเตอรของคุณ 
7. คลิกที่ Exit เพ่ือออกจากหนาจอ Twain 
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3. การเตรียมเอกสารกอนสแกน 
 

1. ตรวจสอบสภาพเอกสาร 
ตรวจสอบขนาด ความหนาและคุณสมบัติอ่ืนๆของเอกสารวาใชไดกับ PS406/ PS406U โดยดูรายละเอียดไดที่หวัขอ 1.8 
คุณสมบัติ PS406 ในคูมือฉบับนี้ 

การสแกนเอกสารจํานวนมากโดยใช ADF scan จะชวยใหคุณทํางานไดสะดวก รวดเร็ว และงายดายยิ่งขึ้น ADF scan 
ของ PS406 / PS406U รองรับกระดาษหลากหลายชนิดที่คุณตองใชเปนประจํา เชน 

1. กระดาษธรรมดาที่มีขนาด ความหนาตามรายละเอียดในหัวขอ 1.8 คุณสมบัติ PS406 
2. กระดาษที่มีรู 
3. กระดาษที่มีการเคลือบผิว เชนโบรชัวรตางๆ 
4. แผนใส (Overhead projector film) 
** เพ่ือปองกันขอผิดพลาดในการสแกนและความเสียหายแกอุปกรณ กรุณาปฏิบัติดังนี้: 
1. ถอดวัสดุเล็กๆออกกอน เชน คลิปหนีบกระดาษ, เข็มหมุดเล็กๆ, แม็กซ ฯลฯ กอนจะทําการสแกนอัตโนมัติ   
2. ตรวจสอบวากระดาษไมยับหรือพับมุม 
3. หลีกเลีย่งการสแกนเอกสารทีเขียนดวยดินสอและหนาหนังสือพิมพที่ถูกตัดออกมา เพราะสิ่งเหลานี้จะทําให

กระจกสแกนและภายในอุปกรณดึงกระดาษอัตโนมัติสกปรก หากคุณจําเปนตองสแกนเอกสารเหลานี้ ใหทํา
ความสะอาดบอยๆ  

4. ชุดเอกสารที่จะสแกนโดยการสแกนอัตโนมัติ มีความหนา(แกรม) ที่ตางกันไดแตความยาวตองเทากัน  
 

** หมายเหต ุ
• ไมใช ADF scan เพ่ือสแกนภาพถายหรือกระดาษที่มีรอยยับ เพ่ือหลีกเลี่ยงความเสียหายตออุปกรณดึง

กระดาษ 
• ไมใสกระดาษทีห่มึกยังไมแหงหรือลิควิดเปเปอรที่ยังไมแหง เพราะจะทําใหกระจกสแกนสกปรกได จึงควรทิ้ง

ไวใหแหงกอนสแกน 
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2. การจัดเรยีงเอกสาร 
 
เพ่ือปองกันปญหากระดาษติด และความเสียหายแกอุปกรณดึงกระดาษอัตโนมัติ กอนสแกนแบบอัตโนมัติ ใหทําดังนี้ 
1. กรีดกระดาษเพื่อไมใหกระดาษติดกัน 
2. เรียงกระดาษใหเปนระเบียบ เทากันทุกดาน โดยทําตามภาพ 
 

 
 

3. การใสกระดาษในการสแกน 
1. การสแกนแบบ ADF 

 

• ใสกระดาษที่ตองการสแกนลงในถาดใสกระดาษดานบน โดยใหหนาที่ตองการสแกน
คว่ําลงและหัวกระดาษขิดดานในสุดของถาดตามภาพ 

• ปรับที่กั้นเอกสารดานขางใหพอดีกับกระดาษเพื่อปองกันเอกสารเอียง  
 

 

 

• หากกระดาษมีความยาวมากกวาปกติ ใหดึงแผนรองเอกสารออกมาจากถาดตาม
ภาพ เพ่ือใหกระดาษไมโคงงอจนเกินไป 

 

• ปรับแผนกั้นกระดาษดานขางใหชิดกับเอกสาร เพ่ือปองกันไมใหกระดาษเอียง 
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2. การสแกนนามบตัร 

 

• ใสนามบัตรในแนวตั้งลงในถาดใสเอกสารตามภาพ 
• เลื่อนที่กั้นกระดาษใหชิดขอบนามบัตรทั้งสองดานเพื่อปองกันนามบัตรเอียง  
• ไมควรใสนามบัตรเกิน 30 ใบตอการสแกน 1 ครั้ง 

4. วิธีการสแกนและใชงานโปรแกรม 
4.1. การสแกนโดยใช DocAction   

DocAction เปนโปรแกรมที่ใชในการตั้งคาการสแกนใหกับปุมตางๆบนตัวเครื่อง ซึ่งโปรแกรมนี้จะชวยใหคุณทํางานได

อยางสะดวก รวดเร็ว และงายดายยิ่งขึ้น วิธีนี้จะชวยไดมากในกรณีที่ตองการสแกนเอกสารที่มีรูปแบบการสแกน

เดียวกัน หรือเก็บภาพไปยังตําแหนงเดียวกัน  
 

4.1.1. การต้ังคาการสแกน (Configure Button Settings) 

1. เปดโปรแกรม ทําได 2 วิธีคือ ดับเบิ้ลคลิกที่ไอคอน  ใน taskbar หรือ คลิกขวาที่  ใน taskbar เมื่อมีเมนู
ข้ึนมาใหเลือก Button Configurations จะไดหนาจอดังภาพ 

 
 

1 
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4.1.1.1. การต้ังคาปุม Scan 
1. คลิกเลือกหมายเลขที่ตองการตั้งคา แลวเลือก Button template เปน Scan utility 

 
 

2. เลือกโปรแกรมที่ตองการใชในการสแกน  

คลิกลกูศรดานขางของ  เพ่ือ 
หากตองการใชโปรแกรมอ่ืน ใหคลิกที่ปุม Add ดานขาง แลวเพิ่มโปรแกรมที่ตองการ สามารถใสเพ่ิมไดไมเกิน 10 
โปรแกรม 

 
 

3. คลิกที่ Save setup เพ่ือเลือกตําแหนงที่จะเก็บไฟล 
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สามารถกาํหนดชื่อไฟลในรูปแบบตางๆไดดังตอไปน้ี 
• Date and time 

o Use operating system setting คือต้ังชื่อไฟลตามวันและเวลาของเครื่องคอมพิวเตอร  
เชน 17-3-2554-16-25-31 เปนตน 

o User-defined คือ ต้ังขื่อไฟลตามรูปแบบ ป-เดือน-วัน, วัน-เดือน-ป, เดือน-วัน-ป  
เชน 2011-03-17-16-25-31 เปนตน  

4. เลือก File format คือการเลือกรูปแบบของไฟลที่ตองการ 

 
แตละแบบสามารถสแกนเปนไฟลตางๆไดดังนี้ 

Color 
คือการเลือกสแกนเปนส ี

Grayscale 
คือการเลือกสแกนเปนระดับทีเทา 

Black & White 
คือการเลือกสแกนเปนขาว-ดํา 

• Jpeg • Jpeg • TIFF – Uncompressed 
• TIFF – Uncompressed • TIFF – Uncompressed • TIFF – Compresses 
• TIFF – Compresses • TIFF – Compresses • PDF 
• PDF • PDF • PNG 
• PNG • PNG • Windows Bitmap หรือ BMP 
• Windows Bitmap หรือ BMP • Windows Bitmap หรือ BMP • Multipage TIFF-Uncompressed 
• Multipage TIFF-Uncompressed • Multipage TIFF-Uncompressed • Multipage TIFF-Compresses 
• Multipage TIFF-Compresses • Multipage TIFF-Compresses  
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5. หากตองการตั้งคาใหกับรูปแบบของไฟลที่ตองการใหคลิกที่ปุม Configure… ดานขวา จะไดหนาจอดังภาพลาง 

 
 
 
 

6. เลือก Scan type คือสแกนแบบอัตโนมัติ (ADF)  
7. เลือกขนาดกระดาษ  

 
 

8. เลือก Scan mode คือ Color, Grayscale หรือ Black & white ซึ่งจะสัมพันธกับ File format ที่เลือกไว 

ใหคุณภาพของภาพ
เหมือนกันทุกโหมด ใหการตั้งคา PDF 

เหมือนกันทุกโหมด 

การตั้งคาสําหรับ
โหมดสี 

การตั้งคา
สําหรับสีเทา 

การตั้งคาสําหรับ
ขาวดํา 

บันทึกทุกหนาใหเปน PDF 
ไฟลเดียว 

บันทึกเปน PDF ทุก X 
หนาที่ระบุ 
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9. เลือกความละเอียดที่ตองการ  

 
 

10. ปรับคาแสง 

 
• Brightness – ปรับความสวาง 
• Contrast – ปรับความคมชัด 
• Gamma – ปรับคาแกมมา 
• Threshold – ปรับคาที่จะแสดงวาเปนขาวหรือดํา (สําหรับภาพ Black & white เทานั้น) 
• โดยปกติใชคา Default ไดเลยไมตองปรับอะไร 

 
11. Color dropout คือการดึงสีแดง, เขียว หรือน้ําเงินออกจากภาพ เพ่ือทําใหภพชัดเจนมากยิ่งขึ้น ใชกับภาพที่เปน 

Grayscale และ Black & white เทานัน 
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12. Descreen คือการปรับมัวเร (Moure’) ของภาพ 

 
 

13. การตั้งคาอ่ืนๆ 

 
 

14. เมื่อตั้งคาทุกอยางไดตามตองการแลว ใหคลิกที ่Apply แลวคลิก OK 
15. ใสกระดาษทีส่แกนเนอรแลวกดปุม Scan  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

สแกนตอเนื่อง 

ปรับความหนาแนนของสีอัตโนมัติ 

ครอบตัดภาพอัตโนมัติ 

ขามหนาวางอัตโนมัติ 

เติมสีขอบของภาพอัตโนมัติ 
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4.1.1.2. การสแกนเปนไฟล 
1. คลิกเลือกหมายเลขที่ตองการตั้งคา แลเลือก Button utility เปน File utility 

 
2. เลือกตําแหนงที่จะเก็บไฟลใน Saving folder 
3. เลือกตั้งชือไฟลใน File name 
4. เลือก File format คือการเลือกรูปแบบของไฟลที่ตองการ 

 
แตละแบบสามารถสแกนเปนไฟลตางๆไดดังนี้ 

Color 
คือการเลือกสแกนเปนส ี

Grayscale 
คือการเลือกสแกนเปนระดับทีเทา 

Black & White 
คือการเลือกสแกนเปนขาว-ดํา 

• Jpeg • Jpeg • TIFF – Uncompressed 
• TIFF – Uncompressed • TIFF – Uncompressed • TIFF – Compresses 
• TIFF – Compresses • TIFF – Compresses • PDF 
• PDF • PDF • PNG 
• PNG • PNG • Windows Bitmap หรือ BMP 
• Windows Bitmap หรือ BMP • Windows Bitmap หรือ BMP • Multipage TIFF-Uncompressed 
• Multipage TIFF-Uncompressed • Multipage TIFF-Uncompressed • Multipage TIFF-Compresses 
• Multipage TIFF-Compresses • Multipage TIFF-Compresses  
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5. ในกรณีที่ตองการตั้งคาไฟล PDF ใหคลิกที่ Configure… เพ่ือต้ังคาการสแกน PDF จะไดหนาจอตามภาพ 

 
6. เลือก Scan type  

 
ADF Front side – สแกนดานหนา 
ADF Rear side – สแกนดานหลัง 
ADF Duplex – สแกนสองหนาพรอมกัน 

7. เลือกขนาดกระดาษ 

 
 

8. สวนการตั้งคาในหัวขออ่ืนเหมือนกับ 4.1.1.1  
9. เมื่อต้ังคาทุกอยางไดตามตองการแลว ใหคลิกที ่Apply แลวคลิก OK 
10. ใสกระดาษทีส่แกนเนอรแลวกดปุม Scan  บนตัวเครื่อง 
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4.2. การสแกนโดยใช Twain Driver 
โปรแกรม TWAIN เปนโปรแกรมที่สําคัญมากที่มาพรอมกับ PS406/ PS406U โปรแกรมนี้ทําหนาที่เปนตัวกลาง
ระหวางเคร่ืองสแกนเนอรและซอฟแวรแกไขภาพ รวมถึงใหคุณปรับการตั้งคาคุณภาพการสแกนได 
4.2.1. เลือกอุปกรณสแกน 

ถาคุณมีสแกนเนอรมากกวา 1 เครื่องติดตั้งอยูแลว คุณจําเปนตองตั้งคาให PS406/ PS406U เปนคาเริ่มตน 
กอนที่จะใชโปรแกรม TWAIN 

4.2.2. สแกนดวย Twain   
สแกนดวย Twain ผาน NewSoft Presto! PageManager: 
1.   คลิกที่ปุม Windows Start แลวเลือกโปรแกรม Presto! PageManager 
2.   ในโปรแกรมPresto! PageManager คลิก Tools > Scan Settings > uncheck “Suppress TWAIN 
User Interface” > OK. Click File > Acquire Image Data. 
3.   ในหนาตาง TWAIN เลือก ADF (Front side) สําหรับการสแกนหนาเดียว หรือ ADF (Double-sided) 
สําหรับการสแกนสองหนา  

 
4.   ปรับแตงคาการสแกน 
5.   คลิกที่ปุม Preview ภาพที่สแกนไดจะปรากฏอยูในชองพรีวิว กําหนดระยะขอบและระยะการครอบตัด

ภาพ โดยใชเมาสคลิกและลากจากมุมใดมุมหนึ่งหรือดานขางของภาพที่พริวิว ต้ังคาการสแกนอีกคร้ังถา
ตองการ 

6.   คลิกที่ปุม Scan  
7.   สิ้นสุดการสแกนคลิกที่ปุม Exit เพ่ือปดหนาตางTWAIN  

 

4.3. การสแกนและใชงาน Plustek DI Capture   

ดับเบิ้ลคลิกที่ไอคอน  บนหนาจอเพ่ือเปดโปรแกรม DI Capture หรือจะไปที่ Start  program  DI 
Capture ก็ได จะไดหนาจอตามภาพ 
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1. จากหนาจอหลัก ใหเลือกสแกนเนอรที่จะใชจากรายการ 

 
 

2. เลือก Folder หรือ Document ที่ตองการจะใชเก็บเอกาสารที่สแกนแลว หากตองการสรางใหม ทําไดดังนี้ 
2.1. การสราง Folder ใหม 
2.1.1. ที่หนาจอซายมือ คลิกเมาสขวาที่ DI Capture แลวคลิกที่ New Folder 

 
2.1.2. ต้ังช่ือที่ตองการแลวคลิก OK 

 
2.1.3. จะได Folder ใหมตามภาพ ใน 1 โฟลเดอรสามารถสรางไดหลาย Document 
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2.2. การสราง Document ใหม 

2.2.1. สราง Document ใหมโดยการคลิกเมาสขวาที่โฟลเดอรที่ตองการ แลวเลือก New Document 

 
2.2.2. ต้ังช่ือ Document  

 
2.2.3. จะได Document ใหมตามภาพ 

 
 

2.3. การแกไข/ลบ Folder หรือ Document 
2.3.1. หากตองการแกไขชื่อ ใหคลิกที่ Folder หรือ Document ที่ตองการแกไขชื่อ จากนั้นคลิกที่ Rename แกไข

ช่ือตามตองการแลวกด Enter 
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2.3.2. หากตองการลบ ใหคลิกที่ Folder หรือ Document ที่ตองการลบ จากนั้นคลิกที ่Delete แลวกด Enter 

3. เลือกรูปแบบการสแกนที่ตองการ จากรายการ หรือ จะสรางรูปแบบใหมก็ได 

 
3.1. การสรางรูปแบบการสแกนใหม (Create New Profile) 

3.1.1. คลิกที่ปุม    จะไดหนาจอตามภาพ ใหใสชื่อ Profile ที่ตองการสรางใหมแลวคลิก Next 

 
3.1.2. เลือกวาจะใหสแกนแบบ Flatbed หรือ ADF จากน้ัน คลกิ Next 
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3.1.3. เลือกขนาดกระดาษที่จะสแกน โหมดสี และชนิดของไฟลที่ตองการ จากนั้นคลกิที่ Next 

 
 

3.1.4. กําหนดการหมุนกระดาษ หรือการครอบตัดอัตโนมัติ จากน้ันคลิก Next 

 
3.1.5. เลือกโหมดสีในการสแกนวาจะใหเปน Color, Grayscale หรือ Black & white จากนั้น เลือกความ
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ละเอียด เสร็จแลวคลิกที ่Save  

 
 
 

3.2. การแกไขรุปแบบการสแกนเดิม (Manage profile) 

3.2.1. คลิกที่ปุม Manage     จะไดหนาจอตามภาพ 

 
3.2.2. เลือก Scan mode วาจะใหเปน Color, Grayscale หรือ Black&white 
3.2.3. เลือกความละเอียด (Resolution) 
3.2.4. คลิก Save หากตองการบันทึกในชื่อเดิม หรือคลิกที่ Save as หากตองการบันทึกเปนชื่อใหม คลิก OK  

 
3.2.5. จากนั้นคลิกที ่Close 
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3.3. การเปลี่ยนชื่อ/ ลบ Profile 

3.3.1. คลิกที่  เลือก Profile ทีตองการเปลี่ยนชื่อ 
3.3.2. คลิกที่ Rename จะขึ้นหนาจอใหใสชื่อใหม จากน้ันคลิก OK 

 
3.3.3. หากตองการลบ Profile ก็ทําในลกัษณะเดียวกัน แตคลิกที่ Delete  

4. หลังจากที่เลือกสแกนเนอร, เลือก Folder, เลือก Document เลือก Profile ในการสแกนเรียบรอยแลว ใหใสเอกสารลง

ไปในถาด ADF หรือวางกระดาษลงบน Flatbed ตามที่กําหนดไวใน Profile แลวคลิกที่ปุม  เพ่ือทํา
การสแกน เมือสแกนเสร็จแลว ภาพเอกสารที่สแกนจะเขามาอยูในโฟลเดอรที่กําหนดไว 

 
 
คําอธิบายแถบเมนู 

4.1. Best fit – การปรับใหภาพใน 1. ใหมีขนาดพอดีกับหนาจอ 
4.2. Zoom in/ Zoom out – การยอขยายภาพใน 1  
4.3. 1:1 Actual scale  - คือการขยายภาพใน 1 ใหไดขนาดจริง 
4.4. Select area – คือการเลือกพ้ืนที่ในภาพเพื่อทําการ Crop 
4.5. Crop – การครอบตัดใหไดขนาดที่ตองการ 

4.5.1. หากตองการเพียงแค Resize ภาพ ใหไปที่ เมนู Image  Resize… จะไดหนาจอตามภาพ สามารถ
เลือกกําหนดขนาดและความละเอียดใหมไดตามตองการ 

2.ภาพยอแสดงทุก
หนาใน Document 

1. ภาพขยาย 
แสดงหนาที่เลือก 
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4.6. Inverse – คือการปรับสีใหตรงขามกับตนฉบับ 

4.6.1. หากตองการ Option ของการปรับสี ใหไปที่ เมนู Image  Convert image type ตามภาพ แลวเลือก Bit 
สีตามตองการ 

 
4.7. Rotate คือการหมุนภาพ 

4.7.1. หากตองการ Option การหมุนภาพที่มากกวานี้ ใหไปที่เมนู Image  Rotate & Flip  แลวเลือก
รูปแบบการหมุนที่ตองการ หากตองการเลือกหมุนทีละองศา ใหเลือกที่ Custom… 
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5. ในกรณีที่ตองการใชฟงกชั่นสแกนสองหนา (Double-sided scanning) ใหทําดังนี้ 

5.1. ไปที่เมนู Scan  Double-sided paper 

5.2. ใสกระดาษที่ตองการสแกนลงในถาด จากนั้นคลิกที ่  รอสแกนจนหมด เลขหนาที่สแกนใน
ครั้งแรกคือ 1,3,5,7....ตามลําดบั 

5.3. พลิกหนาหลังแลวใสลงในถาดสแกน โดยไมตองสลับหนาแตอยางใด  

 
5.4. คลิกที่ Scan Append อีกครั้ง เลขหนาที่สแกนครั้งที่สองคือ ...6,4,3,2 ตามลําดับ 
5.5. โปรแกรมจะจัดเรียงหนากระดาษตามลําดับใหโดยอัตโนมัติ 1,2,3,4,5,6,7… 
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6. การ Import Image เขามาใน Document 
DI Capture สามารถนําเขาภาพที่สแกนไวกอนแลวเขามาใน Document ที่ตองการได ทําไดดังนี้ 

6.1. เลือก Document ปลายทางกอน จากนั้นคลกิที ่   
6.2. เลือกไฟลภาพที่ตองการนําเขามาแลวคลิก Open 
6.3. ภาพที่เลือกจะเขามาอยูใน Document ที่เลือกไว 

7. การสลับหนาเอกสารใน Document เดียวกัน 
7.1. คลิกเลือกภาพที่ตองการยาย คลกิเมาสขวาแลวเลือก Go to page 
7.2. เลือกตําแหนงที่ตองการไปวาง แลวกด Enter 

 
7.3. ภาพที่เลือกจะยายไปยังตําแหนงที่ตองการ 

8. การ Move หรือ Copy เอกสารไป Document อ่ืน 
8.1. เลือกภาพที่ตองการยาย (ถาตองการเลือกหลายภาพใหคลิก Ctrl คางไวแลวเลือกภาพที่ตองการ) 
8.2. คลิกแลวลากไปยัง Document ใหมที่ตองการ 
8.3. จะมีเมนูใหเลือก หากตองการยายใหเลือก Move here ถาตองการทําสําเนาไปยังอีก Document หนึ่ง ใหเลือก 

Copy here 
9. การ Export เอกสารไปยังรปูแบบไฟลชนิดตางๆ 

หลังจากที่จัดเรียงและปรับหนาเอกสารไดตามตองการแลว สามารถ Export ขอมูลเหลานี้ไปเปนไฟลรูปแบบตางๆได
เชน BMP, JPEG, PNG, HTML, TXT, RTF, XLS, PDF เปนตน ทําไดโดย 

9.1. คลิกภาพที่ตองการจะ Export จากนั้นคลิกที ่  จะไดหนาจอตามภาพ 
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9.2. เลือกชนิดของไฟลที่ตองการ แลวคลิก Next จากน้ันจะไดหนาจอตามภาพ 

 
9.3. เลือกตั้งคาดังนี้ 

9.3.1. Generate one PDF file for all pages – คือใหทุกหนารวมเปน PDF ไฟลเดียว 
9.3.2. File name and destination folder – เลือกตําแหนงและชื่อไฟลที่จะบันทึก 
9.3.3. Generate one PDF file every one page – คือใหบันทึก 1 หนา เปน PDF 1 ไฟล 

9.3.3.1. Prompt for saving each file individually – บันทึกแตละไฟลแยกตางหาก 
9.3.3.2. Automatically save file as follow – บันทึกแตละไฟลตามรายละเอียดที่กําหนดไวอัตโนมัติ 

• Destination folder – โฟลเดอรปลายทาง 
• Prefix – คําขึ้นตนของชื่อไฟล 
• Numbering scheme – ตัวเลขที่ตอทาย prefix  

o Starting with – เริ่มตนดวยเลขอะไร 
o Step – ตัวเลขของไฟลถัดไปหางจาก starting with เทาไหร 
o Pad – จํานวนหลักของตัวเลข 

ตัวอยางเชน – Prefix = image, Starting with = 1, Step = 2, Pad = 4 ดังนั้นไฟลที่ไดคือ image00001.pdf, 
image00003.pdf, image00005.pdf,… 

4.4. การสแกนดวย I.R.I.S. Readiris Pro 10 Corporate Edition:   
1. เปดโปรแกรม Readiris Pro 10 Corporate Edition. 

2. คลิกที่  ที่อยูดานซายมือ 
3. ในหนาตาง Twain ใหเลือก ADF (Front side) หากตองการสแกนหนาเดียว หรือ ADF (Duplex) สําหรับการ

สแกนสองหนา 
4. ในกรณีที่ตองการสแกนสองหนา สามารถตั้งคาการสแกนหนาแรกและหนาหลังใหตางกันได โดยการตั้งคาการ

สแกนหนาแรก ใหคลิกที่ปุม Front side และการสแกนหนาหลัง ใหคลิกที่ปุม Rear side 
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5. ใสกระดาษลงไปในเครื่องสแกนเนอร 
6. คลิกที่ปุม Scan 

5. การซอมแซมและดูแลรักษา 
5.1. การทาํความสะอาดสแกนเนอร 

 

ผงแปง, ผุน, หมึก และผงหมึก จากกระดาษทีส่แกนแลวอาจจะทําใหกระจกสแกนและอุปกรณภายในสกปรกได 

สงผลใหคุณภาพการสแกนไมดีเทาที่ควร หรืออาจเกิดขอผิดพลาดขณะสแกนได การทําความสะอาดจะทําให

สแกนเนอรทํางานไดยาวนานและดีข้ึน แตจะทําบอยแคไหนข้ึนอยูกับชนิดของกระดาษและจํานวนที่สแกน ในการ

ทําความสะอาดใหทําอยางเบามือ หามถูแรงๆ 

 คําเตือน 

• กอนทําความสะอาดใหปดสแกนเนอร, ถอด AC Adapter และสาย USB  ของสแกนเนอรออก จากนั้นคอย

สักครูเพ่ือใหกระจกสแกนและอุปกรณภายในเย็นลง 

• ลางมือดวยสบูหลังจากทําความสะอาดสแกนเนอรแลว 
การทําความสะอาดอุปกรณ 

• ใชผาแหง นุม ไมมีขน (หรือ ผาฝาย) ในการทําความสะอาด 
• ใชสารทําความสะอาดที่ไมมีฤทธิ์กัดกรอน เชน Isopropyl alcohol (95%) หามใชน้ํา 

** หมายเหต ุ
• สามารถใชน้ํายาทําความสะอาดกระจกหรือสารทําความสะอาดที่มีฤทธิ์เปนกลางในการทําความสะอาดกระจก

สแกนได แตอยางไรก็ตามหามใชสารเหลานี้ในการทําความสะอาด ADF feed roller or pad module. 
• การใชสารทําความสะอาดอยางอื่นอาจเปนอันตรายกับสแกนเนอรได 

 
5.1.1. การทําความสะอาด ADF 

1. เปดฝาสแกนเนอรโดยการงัดออกมา 

 
2. เช็ดดวยผาชุบน้ํายาทําความสะอาดบิดหมาดอยางเบามือ ระวังอยาใหเกิดรอยขีดขวนบนกระจกสแกน 
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5.1.2. การทําความสะอาด Feed Roller 

เช็ด Feed Roller จากดานหนึ่งไปอีกดานหนึ่ง และหมุนลูกกลิ้งเพื่อเช็ด ทําอยางนี้ไปเร่ือยๆจนกวา 
Feed Roller จนสะอาด 

 
 

5.1.3. การทําความสะอาด Pad Module 
เช็ด Pad Roller จากบนลงลางตามลูกศร ทําอยางนี้ไปเรื่อยๆจนกวา Feed Roller จะสะอาด 
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5.2. การซอมแซมเบื้องตน 
5.2.1. การเปล่ียน Pad Module  

1. เปดฝาสแกนเนอรโดยการงัดออกมาตามภาพ 

 
2. บีบ Pad module ทั้งสองดานพรอมกันแลวดึงออกมา 

 
3. ใส Pad Module อันใหมเขาไปตามภาพ  

 
4. ปดฝาสแกนเนอรใหลงล็อค 
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5.2.1. การเปล่ียน Feed Roller  
1. เปดฝาสแกนเนอรออกโดยการงัดออกมาตามภาพ 

 
2. ถอดแผนรองกระดาษออกโดยการดึงตัวล็อคดานขางออกตามภาพ 

 
 

3. ถอด Feed roller โดยการกดดานขางทั้งสองดานแลวดึงออกมาตามภาพ 
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4. ใส Feed roller อันใหมลงไปโดยวางใหอยูในแนวเดิมและใหลงล็อคตามภาพ 

 

 
 

5. ใสแผนรองกระดาษกลับเขาไปเหมือนเดิม 
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6. ปดฝาสแกนเนอรใหลงล็อค 

 

6. ปญหาและการแกไข 
6.1. การเช่ือมตอกับสแกนเนอร 

 

ในขั้นแรกเมื่อเกิดปญหาในการเชื่อมตอกับสแกนเนอร ใหตรวจสอบวาตออุปกรณครบดวนถูกตองหรือไม ไอคอน  
ที่ปรากฏอยูที่ task bar แสดงวาสแกนเนอรกับคอมพิวเตอรติดตอกันไดแลว  

 

6.2. กระดาษติด 
ถากระดาษติดในอุปกรณดึงเอกสารอัตโนมัติ ใหทําตามขั้นตอนดังนี้ 

1. เปดฝา ADF โดยดึงออกมาตามภาพ 

 
 
3.   ดึงกระดาษออกมาอยางเบามือ พยายามหลีกเล่ียงไมใหกระดาษขาด 
 

ไอคอน สถานะ 

 
โปรแกรมสามารถเรียกใชงานไดและสแกนเนอรกับคอมพิวเตอรเชื่อมตอกันอยางสมบูรณ 
พรอมทําการสแกน 

 
เครื่องสแกนเนอรไมตอเขากับคอมพิวเตอรหรือสแกนเนอรปดอยู 

No Display ไมไดลงโปรแกรม ไมวาสแกนเนอรจะเชื่อมตอกับคอมพิวเตอรหรือไม 
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** อยาพยายามดึงกระดาษที่ติดออกจาก ADF scan โดยไมไดเปด ADF cover เพราะอาจสรางความเสียหายแก ADF ได 

4.   ปด ADF cover โดยการผลักกลับเขาไปจนกระทั่งอุปกรณลงล็อคของมัน และปดสนิททั้งสองดาน 

 

7. การประหยัดพลังงาน 
 

ไฟแสดงสถานะที่สแกนเนอรจะกําหนดใหเปดตลอดเวลาหรือใหปดเองอัตโนมัติในขณะที่ไมใชงานก็ได  

1.   คลิกเมาสขวาที่ไอคอน  ที่ taskbar และเลือก Scanner Utility จากเมนูที่แสดงขึ้นมา 
2.   ในสวนของโหมดประหยัดพลังงาน (Power Save) ในหนาตาง Scanner Utility ใหคลิกเลือกปุมที่ตองการตาม

ภาพ 
- เปดตลอดเวลาคลิกที่ปุม “Keep lamp always on”. 

- ปดสแกนเนอรเมื่อไมไดใชหลังจาก....นาที คลกิที่ปุม “Turn lamp off after the scanner has been idle for 
… minutes” 
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3.   คลิกปุม OK เพ่ือบันทึกและออกจากโปรแกรม 
• ปดสแกนเนอรโดยการกดปุมปดที่ขางเครื่อง 
• ถาสแกนเนอรไมไดใชเปนเวลานานๆใหปดเครื่องและถอดปลั๊กออก 

 
 

8. ติดตอบริษัท 
บริษัท แวค รีเสิรช จํากัด 9 ซ.ลาดพราววังหิน 33 ถ.ลาดพราววังหิน แขวงลาดพราว เขตลาดพราว กทม.10230 
โทร. 025303809-10, 025381038, 025399352 แฟกซ. 025383098 
E-mail : sales@wacinfotech.com Website : www.wacinfotech.com  
 

 


